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ABSTRACT 

Landslides are common hazards that produce devastating effects worldwide. Within the United 

States, the Appalachian Mountains are identified as an area of moderate to high susceptibility 

and incidence for landslides (Mirus et al., 2020; Wieczorek and Morgan, 2008). Given the 

presence of active seismic zones (eastern Tennessee and Giles County seismic zones) and 

variable rainfall due to seasonal storms (hurricanes) throughout the Appalachians, ancient 

earthquake activity or intense rainfall may trigger mass wasting events. Regional bedrock joints 

may further control the susceptibility of landslides to develop in specific locations during trigger 

events by providing a pre-existing weakness in the substrate. This relationship is demonstrated 

by three large rock block slides in the Appalachian Valley and Ridge province downslope of 

ridges where bedrock units are oriented parallel to regional fractures. To investigate the 

distribution of joint orientations and landslide occurrence throughout the southern and central 

Appalachians, I present 3,000 structural measurements of joints collected throughout the 

southern Valley and Ridge province. The discordance between joint orientations and local strike 

of bedrock units is used to (a) identify higher- and lower-risk mass wasting zones, (b) focus 

searches for unmapped, ancient landslides using high resolution digital elevation models, 

including light detection and ranging (LiDAR) based data and (c) to determine if joint 

orientations are influenced by regional basement structures. From these techniques, two mass 

wasting features were identified 60 miles southwest of the Sinking Creek Mountain landslides 

along the same ridge, within the Giles County seismic zone.  
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INTRODUCTION 

 

On average, 25-50 fatalities and billions of dollars in destruction occur annually due to 

landslides (Mirus et al., 2020). In 1980, the average yearly cost of damage caused by landslides 

was more than $1 billion (Fleming and Taylor, 1980). Recently, the United States Geological 

Survey (USGS) has estimated the annual cost of damage caused by landslides has increased to 

between $2 and $4 billion (AGI, 2021), and landslide hazards have been identified in all 50 

states of the U.S. (Mirus et al., 2020). The USGS has labeled the Pacific Northwest, Rocky 

Mountains, and Appalachian Mountains as areas with the highest concentration of landslide 

occurrences and highest susceptibility for landslides (Wieczorek and Morgan, 2008). Within the 

Appalachian Mountains, the Valley and Ridge province has been identified as an area with 

moderate susceptibility and incidence with ~25% of the region labeled as high susceptibility and 

incidence (Wieczorek and Morgan, 2008) (Figure 1). 

The Valley and Ridge province is one of four main physiographic provinces that make up 

the Appalachian Mountains. From east to west, they are the Piedmont, Blue Ridge of the 

Piedmont, Valley and Ridge, and Appalachian Plateau (Hatcher, 2005; Rast 1989) (Figure 2). 

The Valley and Ridge province extends from southeastern New York to northeastern Alabama 

and is characterized by subparallel linear valleys and ridges that trend northeast to southwest. 

Within the Valley and Ridge province, a study of landslides in northeastern Alabama has 

revealed large rock block slides on Colvin Mountain located downslope of areas where the strike 

of the ridge and joint orientation sets become sub-parallel to parallel (McKay and Jackson, 

2019). 
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These landslides have a combined size of ~52,000,000 m3 (McKay and Jackson, 2019) 

and have been identified as joint controlled with no evidence of fluvial undercutting, 

precipitation induced failures, or seismic activity. Another cluster of large landslides was 

identified in southwestern Virginia along the dip slope of Sinking Creek Mountain with a 

combined size of ~100,000,000 m3, with Schultz (1986) suggesting they detach along bedding 

and joint planes (Schultz, 1986). Both landslide occurrences are located within the Valley and 

Ridge province and are near active seismic zones but are located ~400 miles apart.  

Therefore, I hypothesize that joint controlled landslides may be a common characteristic 

of the southern Valley and Ridge province, the propagation of joint orientations may be 

controlled by regional basement structures, and joint controlled landslides can be identified 

based on the workflow in Table 1. Joint orientation sets and the strike of bedrock units are 

presented throughout the Valley and Ridge province from New Castle, Virginia to Birmingham, 

Alabama. Structure data was used to create landslide susceptibility maps and joint orientation 

maps. LiDAR-based DEM data (U.S. Geological Survey, 2020) is utilized to identify previously 

unmapped mass wasting deposits in high susceptibility areas. Joint orientation maps were used to 

determine if Iapetus Ocean rifting basement structures are influencing the orientation at which 

joints are propagating. 
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Table 1. The table displays the Excel and ArcMap workflows for 6 of the 19 figures and how the 

different color schemes were created.  

 

 

 

Figure Workflow Additional Information 

 

Precipitation 

Map 

ArcMap:  

Conversion Tool → To Raster → 

ASCII to Raster Tool  

Data Management Tools → Raster → 

Raster Dataset → Mosaic to New 

Raster  

Spatial Analyst Tool → Map Algebra 

→ Raster Calculator  

 

ASCII to Raster: Output data 

type → FLOAT  

Mosaic to New Raster: Pixel type 

→ 32-bit-FLOAT, number of 

bands: 1 

Raster Calculator: “raster”/1000 

 

Data Station 

ArcMap:  

Display XY Data → X Field = 

Easting → Y Field = Northing → 

Click Edit → Projected Coordinate 

Systems → UTM → NAD 1983 → 

NAD 1983 UTM Zone 16N → OK → 

OK 

Display XY Data → X Field = 

Easting → Y Field = Northing → 

Click Edit → Projected Coordinate 

Systems → UTM → NAD 1983 → 

NAD 1983 UTM Zone 17N → OK→ 

OK  

Right click each layer → Data → 

Export → Export: All features → 

Output feature class → navigate to 

desired geodatabase  

ArcToolbox → Data Management 

Tools → Raster → Raster Dataset → 

Mosaic to New Raster → Input all 

rasters → choose geodatabase output 

→ name → number of bands = 1 → 

OK 

 

DEM creation: Pixel Type needs 

to be the same as the Tif files  

DEM: hillshade with a z factor of 

10 
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Table 1 continued. The table displays the Excel and ArcMap workflows for 6 of the 19 figures 

and how the different color schemes were created.  

Figure Workflow  Additional Information 

Joint Orientation 

Map 

Excel: 

Strike measurement – 180o = 

difference 

=IF([difference]<0, [revert to the 

original number], [keep the number 

the same]) 

ArcMap:  

Spatial Analyst Tools → Interpolation 

→ Nearest neighbor  

 

Input point feature → Joint layer Z 

value field → Difference 

Susceptibility 

Map 

Excel:  

Converted data: strike measurements – 

joint strike measurements → 

ldifferencel 

ArcMap:  

Layer → Properties → Quantities → 

Graduated Colors → 3 categories  

 

 

Landslide DEMs 
ArcMap:  

Data Management Tools → Raster → 

Raster Dataset → Mosaic to New 

Raster 

 

Pixel type must match the original 

LiDAR pixel type  

Number of bands: 1 

Landslide 

Curvature 

ArcMap:  

Spatial Analyst Tool → Surface → 

Curvature 

 

 

Color Schemes 
ArcMap:  

Customize → Style Manager → folder 

being used → Color Ramps → right-

click → New → Present Color Ramp 
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Figure 1. Landslide susceptibility and incidence map for the southern Appalachian Mountains 

modified from Mirus et al., 2020; Wieczorek and Morgan, 2008. Most of the Valley and Ridge 

province is defined as being moderate susceptibility with portions labeled as moderate incidence, 

moderate susceptibility and high incidence and high susceptibility. 
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Figure 2. The Appalachian Mountains are composed of four main physiological provinces: 

Appalachian Plateau, Valley and Ridge, Blue Ridge of the Piedmont, and the Inner Piedmont 

(adapted from Sinha et al., 2012). 
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BACKGROUND 

 

Causes of Mass Wasting in the Eastern U.S.  

Most of the historical landslides that have been documented within the Valley and Ridge 

province were triggered by precipitation events (Kirschbaum et al., 2015; Kirschbaum et al., 

2010). Precipitation is the most common trigger for landslides (Schuster and Wieczorek, 2002; 

Yeh and Lee, 2013; Raghuvanshi, 2017) followed by seismic activity (Korup, 2007). Recent 

research has identified discontinuities as another potential control of large mass wasting events 

(McKay et al., 2016), but research is limited within the Appalachians.  

Precipitation. The intensity and duration of a precipitation event are the key factors that 

trigger landslides (Cuomo and Della Sala, 2013). Intense rainfall over a short period of time, and 

moderate rainfall over a long period of time increase the likelihood of landslide occurrences 

(Schuster and Wieczorek, 2002).  In areas where the soil is normally unsaturated, slope failures 

are linked to heavy rainfall and infiltration (Yeh and Lee, 2013). When heavy rainfall and 

infiltration occur, the pore-fluid pressure increases (Terlien, 1998) which in turn decreases the 

shear strength of the soil (Yeh and Lee, 2013). The depth to which the water infiltrates the soil 

impacts the likelihood of a slope failure and the type of failure (Yeh and Lee, 2013). Typically, 

the direct infiltration of rainfall with a maximum depth of 2 m triggers shallow landslides 

(Terlien, 1998; Cuomo and Della Salla, 2013) and areas that receive less than 8-10 inches of rain 

have fewer identified landslides (Radburch-Hall et al., 1982).  

Based on a 1,000 year, 48-hour precipitation event (Figure 3) (Bonnin et al., 2006; Perica 

et al., 2013), ~70% of the central and southern Appalachians receive 14 inches of rain or less. 

Northeastern Tennessee, southwestern Virginia, and West Virginia receive 6-10 inches of rain, 



8 

receiving the least amount of precipitation for the region. The Great Smokey Mountains region 

receives the most amount of rainfall due to a rain-shadow effect and large storm events that 

occur in this region.  

Between November 3rd and 5th 1985, Tropical Storm Juan collided with other low-

pressure systems (Jacobson et al., 1989; Cenderelli and Kite, 1998) and resulted in ~12 inches of 

rain over the Wills Mountain anticline area located on the border of Pendleton County, West 

Virginia and Highland County, Virginia (Wieczorek et al., 2009). The precipitation event was 

identified to be an 80–300-year frequency storm event (Jacobson, 1993; Jacobson et al., 1993; 

Cenderelli and Kite, 1998). The storm triggered more than 3,000 landslides (Jacobson et al., 

1989; Jacobson et al., 1993; Wieczorek et al., 2009). Most of the triggered landslides were 

identified as slides, slide flows, slumps, and slump flows (Jacobson et al., 1993). The majority of 

the failures were planar slides that were shallow, most being less than 2 m thick, that had minor 

rotational movement (Wieczorek et al., 2009). 

The North Fork Mountain in the southeastern limb of the Wills Mountain anticline 

(Jacobson et al., 1993) produced the largest debris flows that occurred during the storm event 

(Cenderelli and Kite, 1998) (Figure 4). The largest failure has a length of 2,848 m, involving 

13,900 m3 of material (Wieczorek et al., 2009; Cenderelli and Kite, 1998) and was mainly 

composed of sandstone residuum and colluvium (Wieczorek et al., 2009).  

Seismic activity. Seismic activity is another trigger for landslides. The cycling of loading 

and unloading on rocks during an earthquake depends on a multitude of factors: magnitude, focal 

depth, and the frequency of the cycling (Sidle and Ochiai, 2006). The seismic waves produced 

from earthquake activity cause the ground to accelerate horizontally (Sidle and Ochiai, 2006; 

Raghuvanshi, 2017) and can result in slope failures on over-steepened slopes along 
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discontinuities (Sidle and Ochiai, 2006, Highland and Bobrowsky, 2008). Less is known about 

seismically induced mass wasting compared to precipitation, because seismically triggered 

landslides are less common and more difficult to predict (Sidle and Ochiai, 2006). Within the 

eastern United States, the New Madrid seismic zone and the east Tennessee seismic zone are the 

two most active seismic zones and have historically produced devastating earthquakes 

(Steltenpohl et al., 2010; Warrell et al., 2017). Within the Valley and Ridge province of the 

Appalachian Mountains, the east Tennessee seismic zone and the Giles County seismic zone are 

prominent seismic zones.  

New Madrid Seismic Zone. The New Madrid seismic zone is located along the 

Mississippi River between Kentucky, Missouri, Tennessee, and Arkansas and is the most active 

seismic zone in the central eastern U.S. (Baldwin et al., 2005). The New Madrid seismic zone 

roughly lies in the center of the Mississippi embayment (Baldwin et al., 2005), where Late 

Cretaceous coastal marine sediments have accumulated on top of basement structures (Jibson 

and Keefer, 1993).  

The Reelfoot rift is an intracratonic rift that formed (Jibson and Keefer, 1993) during the 

late Precambrian to early Paleozoic (Braile et al., 1982) and lies below the New Madrid seismic 

zone (Jibson and Keefer, 1993; Hildenbrand and Hendricks, 1995; Csontos et al., 2008). The 

Reelfoot rift formed during the breakup of Rodinia (Csontos et al., 2008) and the opening of the 

Iapetus Ocean (Hildenbrand and Hendricks, 1995). During the opening of the Iapetus Ocean, a 

triple junction formed in southwestern Arkansas and two of the failed arms were the Reelfoot rift 

and the Oklahoma aulacogen (Hildenbrand and Hendricks, 1995). Reelfoot rifting began along 

normal faults, but the rift structures are suggested to have formed as strike-slip faults (Csontos et 

al., 2008).  
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Reactivation of the Reelfoot rift faults during the assemblage of Pangea is suggested to be 

the source of seismicity within the New Madrid seismic zone (Csontos et al., 2008; Braile et al., 

1982) as most epicenters produced within the New Madrid seismic zone are bounded in the 

Reelfoot rift grabens (Braile et al., 1982). In 1811-1812, the New Madrid seismic zone has 

produced devasting earthquakes with an estimated moment magnitude of MW = 7.0-7.5 

(Guccione, 2005; Li et al., 2005) are suggested to have been key triggers for at least three large 

landslides within the Mississippi embayment (Guccione, 2005). In total, 221 landslides 

suggested to be triggered by the earthquakes were mapped along the bluffs of the Mississippi 

alluvial plain in western Kentucky and Tennessee (Jibson and Keefer, 1988; Jibson and Keefer, 

1993). Three landslide types were identified along the bluffs: old coherent slides, earth flows, 

and young rotational slumps (Jibson and Keefer, 1988). Old coherent slides are defined as 

rotational slides and translational block slides that stay intact (Jibson and Keefer, 1993). To 

trigger block slides and Earth flows within the New Madrid seismic zone, a minimum magnitude 

of mb = 5.9 was required and a magnitude of mb = 5.3, respectively (Jibson and Keefer, 1993).  

East Tennessee Seismic Zone. The second most active seismic zone in the eastern U.S. is 

the east Tennessee seismic zone (Dunn and Chapman, 2006; Steltenpohl et al., 2010; Hatcher et 

al., 2012; Warrell et al., 2017) that extends for ~300 km from southeastern Kentucky and 

western Virginia to northeastern Alabama within the Appalachian Mountains (Chapman et al., 

1997; Dunn and Chapman, 2006; Powell and Thomas, 2016) (Figure 5). The east Tennessee 

seismic zone is interpreted as an ancient intraplate seismic zone (Powell et al, 2014) presumably 

located in basement structures (Steltenpohl et al., 2010; Levandowski and Powell, 2019).   

The hypothesized origin of the east Tennessee seismic zone is further supported by the 

New York-Alabama and Clingman magnetic lineaments acting as boundaries to the northwest 
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and southeast respectively (Steltenpohl et al., 2010). Most of the earthquakes produced by the 

east Tennessee seismic zone, 80-90%, have occurred between the two magnetic lineaments 

(Steltenpohl et al., 2010). It has been proposed that the New York-Alabama lineament represents 

a boundary between two crustal blocks (Kelly et al., 2017). The boundary is interpreted to be a 

right-lateral strike-slip fault (Steltenpohl et al., 2010) that is not related to the Appalachian 

orogeny (Brandmayr and Vlhovic, 2016), but instead related to an intra-Grenville suture 

(Thomas, 2006) during the creation of Rodinia (Powell and Thomas, 2016).  

Hypocenter depths of 5-26 km (Chapman et al., 1997; Dunn and Chapman, 2006; 

Brandmayr and Vlhovic, 2016; Warrell et al., 2017) further suggest that earthquakes produced by 

the east Tennessee seismic zone are within Precambrian crystalline basement blocks beneath the 

Valley and Ridge province (Powell et al., 2014; Brandmayr and Vlhovic, 2016).  Based on focal 

mechanisms, the seismicity within the east Tennessee seismic zone is suggested to be produced 

by primarily steeply dipping, strike-slip faults (Hatcher et al., 2012; Kelly et al., 2017).  

Historically, the east Tennessee seismic zone has produced earthquakes with a magnitude 

of less than 5 (Powell et al., 2014). The largest earthquake produced by the east Tennessee 

seismic zone was Richter magnitude of 5.1 in Irondale, Alabama in 1916 (U.S. Geological 

Survey, 2021). The second largest earthquakes produced by the zone were in Maryville, 

Tennessee in 1973 and Fort Payne, Alabama in 2003, both with a moment magnitude of 4.6 

(Dunn and Chapman, 2006; Powell et al., 2014; Brandmayr and Vlhovic, 2016). Even though an 

earthquake with a magnitude greater than 5.1 has not been recorded, paleoseismic data suggest 

that the east Tennessee seismic zone has the capability of producing an earthquake with a 

magnitude of ~7.5 (Hatcher et al., 2012; Levandowski and Powell, 2019). Research conducted in 

Dandridge, Tennessee identified earthquake features that suggest an occurrence of a late 
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Quaternary aged earthquake with a Mw ≥ 6.5 ± 0.2, with a 95% confidence interval, produced by 

the east Tennessee seismic zone (Warrell et al., 2017).  

Giles County Seismic Zone. The Giles County seismic zone is ~40 km long and is 

located in southwestern Virginia (Bollinger and Wheeler, 1988), extending from New Castle, 

Virginia to Bristol, Tennessee (Figure 5). The seismicity generated from the Giles County 

seismic zone is interpreted to be in basement rocks below the Valley and Ridge province thrust 

sheets (Munsey and Bollinger, 1985; Kelly et al., 2017), as the earthquakes produced in the area 

are occurring at depths of 7-20 km (Munsey and Bollinger, 1985). It has been proposed that the 

Giles County seismic zone was created from the reactivation of an Iapetus normal fault due to a 

compressional event (Bollinger and Wheeler, 1988). The faults below the Giles County seismic 

zone may be moving is a right-lateral strike-slip motion with some areas displaying reverse 

motion (Munsey and Bollinger, 1985). The faults are most likely striking NE in the southwestern 

portion and NW in the northeastern portion (Munsey and Bollinger, 1985).  

In 1897, the second largest earthquake recorded at that time in the southeastern U.S. and 

the first earthquake to be linked to the Giles County zone was produced (Bollinger and Wheeler, 

1988). The 1897 earthquake is estimated be a moment magnitude of 5.5 (Kelly et al., 2017). The 

estimated maximum magnitude that can be produced by the Giles County seismic zone is a 6.8 

(Bollinger, et al., 1992), but an earthquake of that magnitude has not been documented. Large 

quaternary landslides, including rock block slides and rock slumps (Schultz and Southworth, 

1989), have been linked to the Giles County seismic zone (Schultz and Southworth, 1989; Kelly 

et al., 2017). Sinking Creek Mountain is located near the northeastern portion of the Giles 

County seismic zone and some of the largest landslides occurred along the dip slope of the ridge 

(Schultz, 1986).  
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Discontinuities. Failures can initiate along planes of weakness known as discontinuities. 

Common discontinuities are faults, bedding planes, joints (Shang et al., 2018), foliations, 

cleavage, and schistosity (Wyllie and Mah, 2004). Joints are one of the most abundant type of 

geologic structure and can be found in all types of rocks (Davis et al., 2012). The propagation of 

joints within a structure occurs when the tensile strength of a rock is exceeded from deformation 

(Wyllie and Mah, 2004, Davis et al., 2012), and they typically form perpendicular to the bedding 

plane (Engelder, 2004; Davis et al., 2012). Discontinuities such as joints can increase the 

weakness of a structure and can increase the chance of a failure occurring (Raghuvanshi, 2017).   

One of the main types of failures controlled by discontinuities is a plane failure. Plane 

failures are characterized by the sliding of the failure mass along a single surface that is similar 

to a plane (Norrish and Wyllie, 1996). Plane failures occur in areas where the strike of the 

discontinuity is parallel to the face of the rock (Wyllie and Mah, 2004; Sharma et al., 1995).  

Colvin Mountain is an example of joint-related landslides located within the Valley and 

Ridge province. Colvin Mountain is an east-west trending ridge located within the foreland thrust 

belt in Etowah County, Alabama (McKay, 2016). The ridge extends for 100 km trending ~045o-

055o and then turns ~040o to the southeast, extending for another 18 km (McKay and Jackson, 

2019). The ridge is underlain by the Helena thrust sheet and formed by the exhumation of the 

thrust sheet (McKay et al., 2016).  

Recent structural research on Colvin Mountain has recorded a syntectonic joint set of 

075o-255o (McKay et al., 2016). The strike of the mountain shifts to the SE from the NE and the 

ridge becomes orientated to ~070o, becoming subparallel to parallel with the joint orientations. 

These sections of the ridge are located on the upslope of three large landslides (Figure 6). The 

slides have a combined size of ~52,000,000 m3 (McKay and Jackson, 2019). Other areas along 
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the ridge, where joint and bedding strike orientations were not subparallel to parallel, were 

observed to have few to no large volume mass wasting events, including smaller blocks of 

colluvium (McKay et al., 2016).   

 

Summary of Regional Appalachian Geology and Tectonics 

In eastern North America, the Appalachian Mountains extend ~3000 km from 

Newfoundland to beneath the Coastal Plains of Alabama (Hatcher, 2005) and reside on top of 

Grenville basement rocks (Thomas, 2006). Three Paleozoic orogenies formed the Appalachian 

Mountains: The Ordovician Taconic orogeny, the Devonian-Mississippian Acadian-Neoacadian 

orogeny, and the Pennsylvanian-Permian Alleghenian orogeny (Hatcher, 2005; Merschat et al., 

2005; Thomas, 2006).  

The Appalachian Mountains  represent a full Wilson cycle beginning after the breakup of 

Rodinia and ending with the creation of Pangea (Hatcher, 2010). The supercontinent Rodinia 

was formed during the Grenville orogeny between 900-1300 Ma (Park et al., 2010; Thomas, 

2006), which occurred from multiple continent-continent collisions (Park et al., 2010). Rodinia 

began to rift at ~750 Ma was broken into three separate continents: East Gondwana, West 

Gondwana, and Laurentia (Faill, 1997), forming the Iapetus Ocean between Laurentia and West 

Gondwana (Cawood et al., 2001), initiating the Appalachian orogeny (Williams and Hatcher, 

1982). The Iapetan rift margin is characterized by northeast-striking rift segments that are offset 

by transform faults that strike northwest to southeast (Thomas, 2006) (Figure 7).  

At ~470 Ma, the Taconic orogeny began from the obduction of multiple terranes and 

microcontients (Stowell et al., 2019), closing the Iapetus Ocean (Thomas, 2006; Hatcher, 2010). 

The Acadian-Neoacadian orogeny (~410 Ma- ~345 Ma) (Hatcher, 2005; Stowell et al., 2019) is 
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the second orogenic event caused by the north-to-south closure of the Rheic Ocean (Hatcher, 

2005) from the collision of small terranes and microcontinents with the eastern margin of 

Laurentia (Rast, 1989; Park et al., 2010). During the Taconic and Acadian-Neoacadian, 

sandstones, shales, and carbonates were deposited (Hatcher, 2005) within the Valley and Ridge 

Province (Figure 8). Sandstones, limestones, and shales deposited during the Taconic orogeny 

are currently located on the tops and sides of ridges of the southern Valley and Ridge province. 

The valleys of the Valley and Ridge province are predominatly composed of shales, mudstones, 

and siltstones deposited during the Acadian-Neoacadian orogeny (Figure 8).  

The Alleghenian orogeny is the final orogenic event and was caused by the north-to-

south collision between Gondwana and Laurentia (Secor et al., 1986), closing the Theic Ocean 

(Hatcher, 2005). Gondwanan crust was thrusted more than 330 km onto Laurentian (Hopper et 

al., 2017). The late Devonian to Permian compression created the fold and thrust belt that 

characterizes the Valley and Ridge province today (Hatcher, 1972; Evans and Battles, 1999; 

Hatcher, 2005). Throughout the Alleghenian orogeny, multistage deformation occurred 

(Bartholomew and Whitaker, 2010) and produced five stress fields that caused the propagation of 

discontinuities (Engelder and Whitaker, 2006).  

During the beginning stages of the Alleghenian orogeny, the Appalachian-wide stress 

field was created from the oblique convergence of Gondwana and Laurentia (Engelder and 

Whitaker, 2006). The Appalachian-wide stress field persisted while Gondwana pushed closer 

against Laurentia in a dextral slip motion (Engelder and Whitaker, 2006; Lash and Engelder, 

2007). During the active period of the Appalachian-wide stress field, the compression formed 

discontinuities with an orientation of 085o and a secondary set with an orientation of 355o 

(Bartholomew and Whitaker, 2010). After more than 10 m.y. of dextral slip, the Appalachian-
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wide stress field was disrupted by a stress field that formed from the thrusting of basement 

decollements (Engelder and Whitaker, 2006) and ended in the late Mississippian (Bartholomew 

and Whitaker, 2010). 

Following the Appalachian wide stress field, the Princeton event, produced 

discontinuities with a dominant orientation of 055o and a secondary set at 145o (Bartholomew 

and Whitaker, 2010). The third stress field was formed by a main central Appalachian 

deformation event that occurred in the late Mississippian (Bartholomew and Whitaker, 2010). 

The event produced discontinuities striking 035o with a secondary set striking 120o 

(Bartholomew and Whitaker, 2010). The fourth Alleghenian event had the most widespread 

impact and was the main southern Appalachian deformation event, producing a set of 

discontinuities oriented 070o with a minor set trending 160o (Bartholomew and Whitaker, 2010). 

The final Alleghenian event is defined as a late southern Appalachian deformation event with a 

predominate discontinuity set oriented 095o and a second set oriented 010o (Bartholomew and 

Whitaker, 2010). 
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Figure 3. 1000-year, 48-hour precipitation event for the central and southern Appalachians. 

Precipitation data collected from the NOAA Precipitation Frequency Database (Bonnin et al., 

2006 and Perica et al., 2013). Documented landslides, collected from the NASA Global 

Landslide Catalog (Kirschbaum et al., 2015 and Kischbaum et al., 2010). Table 1 shows the 

workflow for the creation of this map. 
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Figure 4. The debris on Twin Run, North Fork Mountain, West Virginia (Cenderelli and Kite, 

1998) is outlined by the black rectangle (Kite et al., 2019). Imagery from Google Maps (Google 

Maps, 2021). 
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Figure 5. Documented earthquakes and landslides within the southern Appalachians. Earthquake 

data collected from the USGS Earthquake Search catalog (U.S. Geological Survey, 2021) and 

landslide data collected from the NASA Global Landslide Catalog (Kirschbaum et al., 2015; 

Kischbaum et al., 2010). Table 1 shows the workflow for this map. 
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Figure 6. Three large landslides were identified on the northern slope of Colvin Mountain. A is 

the large western landslide, B is the smaller middle landslide, and C is the large eastern landslide 

(Google Maps, 2021). 

 

Figure 7. Prominent basement structures along the eastern Appalachian Mountains are northeast 

trending rifts connected by northwest trending transform faults (modified from Thomas, 2006). 
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Figure 8. For the Valley and Ridge province, a generalized stratigraphic column was created 

based on previous maps and stratigraphic columns. The stratigraphy is based mainly on Alabama 

and Tennessee as most of the data were collected from these two states. Modified from Raymond 

et al., (1988), Szabo et al., (1988), and Hardeman (1966). 
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METHODS AND RESULTS 

 

Field Work   

Data collection included joint set orientations (Figure 9) and strike of regional ridges that 

extend from New Castle, Virginia to Birmingham, Alabama. Three ridges were followed 

throughout the region to determine if the joint features are only located on certain ridges, located 

on certain sides of ridges, or are common characteristic of the province. Approximately, every 20 

miles a data station was constructed. At each data station, between 20 and 100 joints were 

measured, along with the strike of the ridge and lithology.  

  

Joint Data Analysis 

Methods. Throughout the Valley and Ridge province, 57 data stations were constructed 

(Figure 10) and 3051 joints were measured (Appendix: Joint Data). Rose diagrams were used to 

visualize the primary and second most prominent joint orientation sets for each data station. Rose 

diagrams were created in Stereonet (Allmendinger, 2020), using a bin size of 10o and were 

treated as axes to see the full strike of the joints (Table 2). The data stations were divided into 

eight sections, A-H, based on the location of Iapetan basement transform faults (Figure 11), to 

create a more regional study of the joint orientations compared to an individual analysis of each 

data station. The strike of the joints is used to determine the stress field and tectonic event that 

formed the joints. Using dip frequency histograms with bin sizes of 5o, the dip of the joints is 

used to determine the timing of joint propagation (Figure 12).   

Results. The most prominent joint strike orientations of the region were 105o- 095o, and 

345o. The joints in section A have a primary and secondary average strike of ~090o and ~104o, 
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respectively. Section G had a similar trend with a primary joint orientation of ~099o and a 

secondary joint orientation of ~063o. Section H has a primary joint orientation of ~049o and 

secondary joint orientation of ~087o. The primary joint orientation in section G trends parallel to 

the basement transform faults and the intracratonic basement faults of the Birmingham graben. 

The primary joint set of section H and the secondary joint sets for both sections, G and H, trend 

sub-parallel to parallel of the intracratonic basement faults located in northeastern Alabama 

(Figure 7).  

The primary and secondary strike of the joints in section B is ~065o and ~145o, 

respectively. Section C has joints predominatly striking WNW. The primary and secondary joints 

in section D have a trend of ~105o and ~095o, respectively. The primary joint sets for sections E 

and F trend ~092o and ~98o, respectively. Section E has a secondary joint set striking ~093o, but 

section F has a secondary joint set striking ~080o.  

Using the orientation and dip of the joints, timing and potential control for propagation 

can be determined (Engelder, 2004). If the dip of the joint is 80o or more, the joints formed after 

the rocks were deformed (Engelder, 2004). Joints dipping predominatly between 40o-80o indicate 

that propagation occurred during the folding events (Engelder, 2004). If the dip of the joint is 40o 

or less, the joints formed before the rocks were deformed and the dip orientation was altered 

through the deformation process (Engelder, 2004).   

Based on Figure 12, most of the joints for the region dip between 40o -90o. The northern 

and southern most sections (Figure 12-A, G, and H) have joints that predominantly dip between 

75o-90o. The north central sections, B, C, and D, have a wider variety of dip angles (Figure 12-B, 

C, and D) ranging between 40o-80o. The south-central sections (Figure 12-E and F), contain 

joints that mainly dip between 60o-90o with a handful of joints dipping between 25o-55o.  
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Bouguer Gravity Anomaly Data  

Methods. A gravity anomaly map was created using Bouguer gravity data from the 

National Geospatial-Intelligence Agency and the program Oasis Montaj (Geosoft Incorporated, 

2021). The gravity data was converted to UTM zone 17N and gridded using a minimum 

curvature, a 2 km spacing, and a sun angle of 45o. The basement faults (Thomas, 2006) were 

overlain on top of the gravity map to visualize the location of basement structures (Figure 13).  

Results. Three distinct zones are identified by different gravity measurements: 

Birmingham, Gadsden to Chattanooga, and eastern Tennessee (Figure 13). The Birmingham area 

has a relatively uniform gravity anomaly of -40 to -30 mGal with a small area with higher 

anomaly readings concentrated around intracratonic basement faults. The Gadsden to 

Chattanooga area mainly has gravity readings between -40 and -30 with more positive readings 

concentrated around intracratonic basement faults. The eastern Tennessee area has 

predominantly negative gravity anomaly readings between -40 and -30. The area also contains a 

linear low gravity reading located just to the west of the Tennessee and North Carolina border. 

Iapetan rifts and transform faults are predominantly located in areas defined by gravity highs.  

 

Joint Controlled Landslide Susceptibility Classification 

Methods. Joint controlled landslide susceptibility maps (Figure 14) were created by 

finding the difference between the joint orientation and the strike of the bedding at each data 

station (Table 1). Landslide joint susceptibility maps (Figure 14) were created using three levels 

of susceptibility defined as the following: a joint and bedding plane difference of 0o-10o is high 

susceptibility, 10.01o-20o is moderate susceptibility, and >20o is low susceptibility (Table 1). 

Colvin Mountain joint data is included within the susceptibility maps to determine if the above 
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classification of susceptibility would hold as joint controlled landslides were identified 

downslope of areas where the joint and bedding orientations were parallel to sub-parallel.  

The DEM created for the data station map was added to the susceptibility maps to show 

the topography of the region. Documented landslides from the NASA Global Landslide Catalog 

(Kirschbaum et al., 2010; Kirschbaum et al., 2015), along with outlines of the east Tennessee 

seismic zone and the Giles County seismic zone were overlain on the susceptibility maps to 

determine if there is any connection between high susceptibility stations and locations of known 

landslides and active seismic zones.  

Results. From both susceptibility maps, 17 data stations were identified as areas of high 

landslide susceptibility and seven of those were identified from the primary joint susceptibility 

map (Figure 14). For the primary susceptibility map, all the high susceptibility data stations are 

located either in the northern portion, southern portion, or on the edges of the Valley and Ridge 

province. The secondary susceptibility map displays a similar trend with most of the high 

susceptibility data stations located either in the northern portion or on the very eastern edge of 

the Valley and Ridge province.  

 When the seismic zones are overlain on top of the susceptibility maps, three of the 

primary high susceptibility stations and seven of the secondary high susceptibility stations are 

located within the east Tennessee seismic zone and the Giles County seismic zone (Figure 15). 

Regarding documented landslides, most of the failures are occurring within the two seismic 

zones. Two of the primary high susceptibility joint stations are located within 20 mi of 

documented landslides and both are located near the Colvin Mountain landslides (Figure 15).  

From the secondary joint failure susceptibility map, five of the high susceptibility stations are 
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located within 15 mi of the documented landslides (Figure 15) with one of the data stations 

located almost directly on the documented landslide in southwestern Virginia.  

 

Identified Mass Wasting Features  

Methods. The primary joint susceptibility map was used to search for mass wasting 

features in high susceptibility areas. Original Product Resolution DEM data from the USGS 

3DEP database was downloaded for areas surrounding data stations labeled as high 

susceptibility. For each data station, the DEMs were mosaiced together in ArcMap to create a 

cohesive topographic view of each area (Table 1). The DEMs were then processed using the 

curvature tool to identify concave areas that may represent mass wasting features (Table 1).  

Results. Two mass wasting features were identified near station 5 in southwestern 

Virginia. A feature was identified on the dip slope just south of station 5 between stations 12 and 

5 (Figure 16-D) from the high-resolution DEM (Figure 16-A). Using the curvature tool, the 

feature is more clearly defined (Figure 16-B). Other landslides were identified and mapped close 

to this feature (Figure 16-C). Along the same ridge further to the northeast, a previously mapped 

landslide was identified upslope of where station 5 is (Figure 17). All of the identified mass 

wasting features were found within ~60 mi of the Sinking Creek Mountain landslides (Figure 

18).  
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Table 2. This table displays the workflow used to create the rose diagrams for each data station 

and the rose diagram with all the joint measurements within Stereonet.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 9. Joint data being collected from an outcrop in Tennessee by the author. 
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Figure 10. Joint data collected throughout the Valley and Ridge province from New Castle, 

Virginia to Birmingham, Alabama. Data stations are shown as pink circles with their 

corresponding station number (Table 1). Rose diagrams were created for each station’s joint 

measurements (Table 2) but, a rose diagram displaying all of the joint measurements is presented 

here. A DEM of the research area was created using high resolution DEM data from the USGS 

3DEP database (U.S. Geological Survey, 2020). 

 

 

 

 

 

 

 

 

 

 



29 

Figure 11. Data stations were divided into eight zones, A-H, based on the orientation of the 

Iapetan transform faults. Modified from Thomas, 2006. 
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Figure 12. –The data stations were broken up into the following sections based on Figure 11 A: 

1-15, B: 16, C: 35-41, 45, D: 32-34, 42-44, 46, E: 47-51, 31, F: 52-54, 28-30, G: 17-19, 22-27, 

and H: 20, 21, 55-57. The dip angles are located on the y-axis and the frequency is on the x-axis.  
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Figure 13. A gravity anomaly map was created for the southern Appalachians using data from 

the National Geospatial-Intelligence Agency. Basement faults (adapted from Thomas, 2006) are 

overlain on top of the gravity map in blue. Gravity map was created using the program Oasis 

Montaj (Geosoft Incorporated, 2021). 
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Figure 14. Susceptibility maps were created based on the difference between the average joint 

orientation and the strike of the ridge for each station. Table 1 and 2 show the workflow and 

color scheme for these maps, respectively. 
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Figure 15. Documented landslides from the NASA Global Landslide Catalog (Kirschbaum et al., 

2010; Kirschbaum et al., 2015) are symbolized as blue triangles and are overlain on top of the 

susceptibility maps. The east Tennessee seismic zone and the Giles County seismic zone were 

modified from U.S. Geological Survey, 2016 and Division of Geology and Mineral Resources, 

2015 are also overlain onto both susceptibility maps. 
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Figure 16. A large mass wasting event was initially identified using high resolution DEM data 

(A). The curvature tool was then used to construct a more defined image of the feature (B). 

Previous mappers identified the feature as colluvium and identified other landslides to the 

northeast along the same ridge (C). The feature is located on the dip slope of the ridge. The event 

is located between stations 5 and 12 and is represented by the blue star (D). Figure 17-C 

modified from Schultz et al., 1991. The workflow for A and B can be found in Table 1. 
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Figure 17. Previous mappers identified a small landslide (A) located upslope of station 5 (B). A 

modified from Schultz et al., 1991. 

 

 

 
Figure 18. Landslides found between stations 5 and 12 (A) and the landslide documented at 

station 5 (B) are all within 60 miles along the same ridge as the Sinking Creek Mountain 

landslides (C). All the landslides are located on the dip slope of the ridge. Modified from Schultz 

et al., 1991. 
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DISCUSSION  

 

Joint Timing and Propagation Mechanism 

Basement faults formed from the creation of the Iapetus Ocean and the formation of five 

Alleghenian stress-fields may have largely influenced the orientation of joint propagation in the 

southern Appalachian Valley and Ridge Province. The regional basement structures, specifically 

the transform faults, and a large portion of the joint sets strike WNW to ESE with a few 

variations striking NE to SW (Figure 19). The primary and secondary joint orientations located 

in northeastern Alabama and northwestern Georgia predominantly strike at the same orientation 

as the intracratonic basement faults located within that region. 

Based on the large range of dip angles for the north central sections (Figure 12- B, C, and 

D), it is interpreted that the joints formed during folding. The number of dips greater than 80o 

may indicate jointing occurring at the very end of deformation. Both joint sets for section B, 

primary and secondary joint set of ~065o and ~145o respectively, have a similar joint orientation 

set as the fourth Alleghenian event as described by Bartholomew and Whitaker, (2010). The 

event is defined as the main southern Appalachian deformation event (Bartholomew and 

Whitaker, 2010) with a primary joint set trending 070o and a secondary joint set trending 160o.  

Most of the joints in section C dip between 55o-80o, suggesting joints formed during 

folding. The primary and secondary joint orientations strike WNW-ESE, parallel to the Iapetus 

basement transform faults and a late southern Appalachian event which is defined as the last 

Alleghenian deformation event (Bartholomew and Whitaker, 2010). Two data stations in section 

C have primary and secondary joint sets trending NE-SW, similar to the Appalachian wide stress 
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field which formed before deformation began during the Alleghenian orogeny (Engelder and 

Whitaker, 2006), and may explain the handful of joints with dips less than 40o.  

Section D has a similar dip variation as section C, suggesting that the majority of the 

joints formed during folding with outliers forming pre- and post-folding. Based on the primary 

and secondary joint orientation sets of 105o and 095o respectively, it can be interpreted that these 

joints formed during the last southern Appalachian event (Bartholomew and Whitaker, 2010) and 

may be influenced by the basement transform faults.  

The joints in the south-central sections (Figure 12 E and F) are suggested to have formed 

either during or after deformation. Both the average primary joint set (~092o) and the average 

secondary joint set (~093o) for section E are striking at a similar orientation as the basement 

faults and the final southern Appalachian event, suggesting propagation during the creation this 

stress field. Section F has an average primary set striking sub-parallel with the basement faults at 

~098o. The secondary joint set is striking sub-parallel with the main and final southern 

Appalachian events at ~080o. These are the final two stress fields of the Alleghenian orogeny 

(Bartholomew and Whitaker, 2010) and are suggested to be the mechanism for which joints 

propagated in section F.  

The joints measured in the northern most and southern most sections of Figure 15 (A, G, 

and H) are suggested to have formed post-deformation based on the high dip angles. Based on 

predominatly NW striking joints (Figure 20), it can be interpreted that the basement faults 

influenced the propagation of these joints. Specifically, the Birmingham graben in Alabama and 

Georgia may largely be influencing both the primary and secondary joint sets in sections G and 

H based on the joint orientations in Figure 19. The less prominent NE striking joints of section A 
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may be linked to the Giles County seismic zone as the stress field had a maximum horizontal 

compression of ~065o (Bartholomew and Whitaker, 2010).   

 

Landslides Identified in High-Risk Zones 

Sections A, G, and H, have the highest susceptibility for landslides based on the joint 

failure susceptibility maps. These areas are located outside of the main east Tennessee seismic 

zone where large earthquakes are infrequent and large landslides and mass wasting features have 

been identified in these sections. Two mass wasting features were identified in section A, located 

within ~60 mi of the Sinking Creek Mountain landslides which are some of the largest 

landslides, combined size of 100,000,000 m3, within the Appalachian Mountains (Schultz, 1989).  

The first mass wasting event was identified between station 5 and 12 (Figure 16-A, B, 

and D), located on the dip slope of the ridge, and was originally identified as colluvium by 

previous researchers (Schultz et al., 1991) (Figure 16-C). Previous researchers (Schultz et al., 

1991) mapped the feature as smaller than what was identified in this study. Other large landslides 

were identified in the surrounding area along the dip slope, and the previous misidentification of 

this event may be due to the lack of technology at the time of mapping. 

Farther to the northeast of this slide, another small landslide (Figure 17) was identified 

upslope of station 5 by the same researchers. The landslide is located on the same ridge as the 

previous slides and is located on the dip slope. Based on the previous identification of large 

landslides near these high susceptibility areas, it can be inferred joints are acting as a control of 

mass wasting events, mainly within the northern and southern portions of the Valley and Ridge 

province. Landslides documented by NASA are scattered across the Valley and Ridge province 
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(Figure 15), but most of these landslides were triggered by precipitation events (Kirschbaum et 

al., 2010; Kirschbaum et al., 2015). 
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Figure 19. – Joint orientation maps were created to determine the regional strike of the region in 

relation to basement faults. The joint orientations were converted to the eastern quadrants. The 

stress maps were created using the nearest neighbor tool (Table 1) using a bin size of 15. 

Regional basement faults are overlain on top of the stress maps (modified from Thomas, 2006). 
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CONCLUSION 

 

Joint orientation measurements were collected from New Castle, Virginia to 

Birmingham, Alabama to determine if the occurrence of joint-related landslides is prevalent 

throughout the Valley and Ridge province and if regional basement structures influence the 

orientation at which joints propagate. From the structural data, rose diagrams were constructed 

and the primary, and secondary joint orientations for each data station were determined. 

Regional stress maps and landslide susceptibility maps were created using the primary and 

secondary joint orientations. Areas identified as high-risk landslide zones were investigated for 

landslide features using high-resolution, LiDAR derived DEMs and mass wasting features were 

found in 3 of 7 high-risk zones in active seismic zones, demonstrating a tentative correlation 

between joint orientations and mass wasting susceptibility. The 3 mass wasting features were 

identified at the northern and southern most regions of the research area.  

Regional stress maps were created to determine if basement structures had an influence 

over the orientation of joint propagation. Based on these maps, I interpret that the orientation of 

joints within the southern Valley and Ridge province are influenced by basement structures 

formed during the creation of the Iapetus rift margin during the breakup of Rodinia and the stress 

fields created during the collision of Laurentia and Gondwana. It can further be interpreted joint-

controlled landslides are a common characteristic that is prevalent throughout the Valley and 

Ridge province with the highest-risk areas located in the very northern and southern portions. 

Joint controlled landslides have been identified in northeastern Alabama by previous researchers 

and mass wasting features have been identified in high-risk areas of southwestern Virginia from 

data collected in this study. 
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APPENDIX  

 

Joint Data  
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Station Strike Dip Dip 

Direction 

Strike Dip Dip 

Direction 

Easting Northing 

1 205 80 SW 283 2 NW 572245 4147559 

1 190 85 SW           

1 190 86 SW           

1 195 84 SW           

1 195 84 SW           

1 195 84 SW           

1 195 84 SW           

1 195 84 SW           

1 195 84 SW           

1 195 84 SW           

1 195 84 SW           

1 195 84 SW           

1 195 84 SW           

1 195 84 SW           

1 86 86 SSE           

1 81 86 SSE           

1 84 86 SSE           

1 84 86 SSE           

1 84 86 SSE           

1 84 86 SSE           

1 84 86 SSE           

1 84 86 SSE           

2 90 84 S 250 15 SE 575992 4149398 

2 270 84 S           

2 272 85 S           

2 271 84 S           

2 271 84 S           

2 271 84 S           

2 271 84 S           

2 271 84 S           

2 271 84 S           

2 271 84 S           

2 271 84 S           
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2 271 84 S           

2 271 84 S           

2 271 84 S           

2 271 84 S           

2 271 84 S           

2 271 84 S           

2 271 84 S           

2 271 84 S           

2 271 84 S           

2 271 84 S           

2 271 84 S           

2 271 84 S           

2 271 84 S           

2 271 84 S           

2 271 84 S           

2 271 84 S           

2 271 84 S           

2 271 84 S           

2 271 84 S           

2 271 84 S           

2 271 84 S           

2 271 84 S           

2 271 84 S           

2 271 84 S           

2 271 84 S           

2 182 65 W           

2 176 65 WSW           

2 175 65 WSW           

2 178 65 WSW           

2 178 65 WSW           

2 178 65 WSW           

2 178 65 WSW           

2 178 65 WSW           

2 178 65 WSW           

2 178 65 WSW           

2 178 65 WSW           

2 178 65 WSW           

2 178 65 WSW           

2 178 65 WSW           

2 178 65 WSW           

2 178 65 WSW           
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2 178 65 WSW           

2 178 65 WSW           

2 178 65 WSW           

2 178 65 WSW           

2 178 65 WSW           

2 178 65 WSW           

2 178 65 WSW           

2 178 65 WSW           

2 211 88 SE           

2 210 70 NW           

2 210 79 SE           

2 210 79 SE           

2 210 79 SE           

2 210 79 SE           

2 210 79 SE           

2 210 79 SE           

2 210 79 SE           

2 210 79 SE           

2 210 79 SE           

2 86 83 ENE           

3 31 82 SE 52 21 SE 565738 4140733 

3 31 82 SE           

3 31 82 SE           

3 31 82 SE           

3 31 82 SE           

3 31 82 SE           

3 210 81 SE           

3 30 89 NW           

3 32 76 SE           

3 295 82 NE           

3 295 82 NE           

3 295 82 NE           

3 295 82 NE           

3 295 82 NE           

3 295 82 NE           

3 295 82 NE           

3 295 82 NE           

3 295 82 NE           

3 295 82 NE           

3 295 82 NE           

3 295 82 NE           
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3 295 82 NE           

3 295 82 NE           

3 295 82 NE           

3 295 82 NE           

3 295 82 NE           

3 295 82 NE           

3 295 82 NE           

3 295 82 NE           

3 295 82 NE           

3 295 82 NE           

3 295 82 NE           

3 295 82 NE           

3 295 82 NE           

3 300 76 NE           

3 293 85 NE           

3 293 84 NE           

3 262 67 NNE           

3 236 77 NW           

3 236 77 NW           

3 236 77 NW           

3 236 77 NW           

3 236 77 NW           

3 236 77 NW           

3 236 77 NW           

3 236 77 NW           

3 236 77 NW           

3 236 77 NW           

3 236 77 NW           

3 236 77 NW           

3 236 77 NW           

3 236 77 NW           

3 236 77 NW           

3 244 77 NW           

3 225 75 NW           

3 234 80 NW           

4 337 76 SW 63 52 SE 546273 4126579 

4 337 76 SW           

4 337 76 SW           

4 337 76 SW           

4 337 76 SW           

4 337 76 SW           
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4 337 76 SW           

4 337 76 SW           

4 337 76 SW           

4 337 76 SW           

4 337 76 SW           

4 337 76 SW           

4 337 76 SW           

4 337 76 SW           

4 336 80 SW           

4 348 72 SW           

4 327 76 SW           

4 205 42 SE           

4 205 42 SE           

4 205 42 SE           

4 205 42 SE           

4 205 42 SE           

4 205 42 SE           

4 15 54 NW           

4 215 30 SE           

4 84 40 NW           

4 84 40 NW           

4 84 40 NW           

5 64 76.5 SE 250 23 SE 517832 4112733 

5 64 76.5 SE           

5 64 76.5 SE           

5 64 76.5 SE           

5 64 76.5 SE           

5 64 76.5 SE           

5 64 76.5 SE           

5 64 76.5 SE           

5 64 76.5 SE           

5 64 76.5 SE           

5 64 76.5 SE           

5 64 76.5 SE           

5 64 76.5 SE           

5 64 76.5 SE           

5 64 76.5 SE           

5 64 76.5 SE           

5 64 76.5 SE           

5 64 76.5 SE           

5 63 71 SE           
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5 65 82 SE           

5 164 82 SW           

5 164 82 SW           

5 164 82 SW           

5 164 82 SW           

5 164 82 SW           

5 164 82 SW           

5 164 82 SW           

5 164 82 SW           

5 164 82 SW           

5 164 82 SW           

5 164 82 SW           

5 164 82 SW           

5 164 82 SW           

5 163 79 SW           

5 345 85 NE           

6 82 83 NW 215 5 SE 480470 4100164 

6 82 83 NW           

6 82 83 NW           

6 82 83 NW           

6 82 83 NW           

6 82 83 NW           

6 82 83 NW           

6 82 83 NW           

6 82 83 NW           

6 82 83 NW           

6 85 86 NNW           

6 80 81 NW           

6 154 81 NE           

6 154 81 NE           

6 154 81 NE           

6 154 81 NE           

6 154 81 NE           

6 154 81 NE           

6 154 81 NE           

6 154 83 NE           

6 154 79 NE           

6 294 85 NE           

7 340 77 NE 62 57 SE 568518 4154000 

7 340 77 NE           

7 340 77 NE           
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7 340 77 NE           

7 340 77 NE           

7 340 77 NE           

7 340 77 NE           

7 340 77 NE           

7 340 77 NE           

7 340 77 NE           

7 340 77 NE           

7 340 77 NE           

7 340 77 NE           

7 340 77 NE           

7 340 77 NE           

7 340 77 NE           

7 340 77 NE           

7 340 77 NE           

7 340 77 NE           

7 340 77 NE           

7 340 77 NE           

7 340 77 NE           

7 340 77 NE           

7 340 77 NE           

7 340 77 NE           

7 340 77 NE           

7 340 77 NE           

7 340 77 NE           

7 340 77 NE           

7 340 77 NE           

7 340 77 NE           

7 340 77 NE           

7 340 77 NE           

7 340 77 NE           

7 348 75 ENE           

7 340 75 SW           

7 330 80 NE           
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